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Introduction

The ScanWizard Medi is a scanning software which is specifically designed for
the use of the X-ray film scanning. This manual covers the various commands
and features found in the ScanWizard Medi scanning software for the Windows
system. The manual information is divided into four major sections,
corresponding to the four major windows of the program:

• Preview

• Settings

• Information

• Scan Job Queue

The ScanWizard Medi functions do not apply to all scanner models. See the
table below to determine which function can be used for your scanner model.

Medi-7000  Medi-6000 Plus Medi-6000 Medi-5000 Medi-3200 Medi-1200     Medi-2200 Plus Medi-2200

Reflective Scan  v v  v v v

Auto Scan v v

Auto Film Feeder v

Auto Density v v v v v

Auto Exposure v v

Custom Exposure v v v v v

Auto-crop v v v v v v v v

Auto-deskew v v v
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The ScanWizard Medi Interface

ScanWizard Medi consists of four major windows:  Preview, Settings,
Information, and Scan Job Queue.

All four windows appear automatically after ScanWizard Medi is started up the
first time. You may hide or show the Scan Job Queue and Information windows
by clicking on the Hide/Show toggle commands in the View menu of the Preview
window.  Take note that the Preview and Settings windows appear only at the
first time to use for some scanner models (e.g., Medi-7000).

Settings
window
contains

scanning
parameters for

outputting the
image and

includes image
correction tools

Information window
provides information on
the Preview image

Preview window
has commands and tools for
controlling the scanner

Scan Job
window

provides key
functions in

managing
scan jobs
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Launching ScanWizard Medi

ScanWizard Medi can be launched in either Stand-alone or Plug-in mode.

• From Stand-alone mode:  Double-click the ScanWizard Medi icon on the
desktop, or choose Start, Programs, Microtek ScanWizard Medi for Windows,
and then ScanWizard Medi

• From Plug-in mode:  Choose the Import or Acquire command from the File
menu of your image-editing software, then select Microtek ScanWizard Medi.

Exiting ScanWizard Medi

To exit ScanWizard Medi, double click on the Close box on the upper left side of
the Preview window.

Click here to exit
ScanWizard Medi
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The Preview Window

The Preview window is the most prominent window, which includes various
commands and tools for controlling the scanner. There are two control panels
presented in the Preview window, Smart and Standard panels, depending on the
Scan Material chosen in the Preview window.

The Preview window in the X-ray mode
In the X-ray mode, both of the two panels of the Preview window (Smart and
Standard panels) are available. Choose either of these two panels as the one you
like to use for the Preview window. Only the functions supported by the selected
panel will be displayed in the Preview window.

Elements of the Preview window
(for X-ray mode only)

G

The Preview window in
Smart  panel
offers a simple and
easy way to complete a
scanning session. This
is also the default
Preview window in the X-
ray mode.

The Preview window in
Standard panel
provides you additional scan functions
for greater controls over the entire
scanning process.

I
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A. Menu bar:  The Menu bar includes the different menus for setting up the
scanner (Scanner menu), controlling view options (View menu),
customizing the software (Preferences menu), Image Correction function
(Correction menu), and accessing on-line help (Help menu).

B. Smart-Scan button:  Performs the final scan and delivers the scanned image
to an assigned folder or application.  Click and hold the mouse to switch to
the option menu if your scanner implement is set either as the auto film
detection or the Auto Film Feeder (AFF) feature.

Auto Scan:   This will be the default option menu button only if when the
scanner implements the auto film detection feature, allowing the scanner to
detect and to scan the X-ray film automatically , and then to deliver the
scanned images to your preferred folder or application.

Auto Film Feeder:  This function is available only when the scanner
supports the Auto Film Feeder (AFF),  allowing the scanner to scan multiple
pieces of  X-ray film at one time.

C. Unit of Measurement:  Select the unit of measurement for the rulers by
clicking the arrow button at the 0,0 point of the rulers and choosing from
the drop-down menu.

D. Overview button*:  This button previews the entire scan bed.

E. Prescan button*: This button previews one or more detailed images of the
area(s) selected by the Frame (Scan Frame) tool.

F. Rulers:  Rulers are located on both sides of the Preview window to help you
with measurement and alignment.

G. Preview area:  The overview image is displayed in this area after you
perform a scan. Notice that this area may appear blank after you perform a
scan when you work on certain scanner models (e.g., Medi-7000).

H. Resize:  To increase or decrease the preview window, drag the bottom right
corner of the window to resize.

I. Status bar:  This area shows you information pertinent to the operation
underway or being performed.

J. Toolbar:  The buttons in the Toolbar perform specific actions on the
overview image. Tool buttons include the Scan Frame (Frame) tool, Zoom
(Magnify Glass) tool, Move (Pan) tool, and Pickers tool*.

K. Scan to button*:  This button starts the final scanning process.

* The button appears on the Preview window only when the Preview window is switched to
Standard panel.
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L Scan Material button:  This shows the type of your scan material – X-ray
(positive films) or Reflective (photos and prints).

M. Switch button: This allows you to switch between two different panels of the
Preview window.

N. Minimize button:  Click it to minimize ScanWizard Medi.

O. Exit button:  Click it to close ScanWizard Medi. Take note that when you
exit, you quit from ScanWizard Medi scanning software.
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Elements of the Preview window
(for Reflective mode only)

The Preview window in the Reflective mode
In the Reflective mode, the Preview window acts as the Preview window in
Standard panel of the X-ray mode, which provides you additional scan functions
(Overview, Prescan, and Scan to) for greater controls over the entire scanning
process.
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A. Menu bar:  The Menu bar includes the different menus for setting up the
scanner (Scanner menu), controlling view options (View menu), customizing
the software (Preferences menu), Image Correction function (Correction
menu), and accessing on-line help (Help menu).

B. Unit of Measurement:  Select the unit of measurement for the rulers by
clicking the arrow button at the 0,0 point of the rulers and choosing from
the drop-down menu.

C. Overview button:  This button previews the entire scan bed.

D. Prescan button: This button previews one or more detailed images of the
area(s) selected by the Frame (Scan Frame) tool.

E. Rulers:  Rulers are located on both sides of the Preview window to help you
with measurement and alignment.

F. Preview area:  The overview image is displayed in this area after you
perform a scan.

G. Resize:  To increase or decrease the preview window, drag the bottom right
corner of the window to resize.

H. Status bar:  This area shows you information pertinent to the operation
underway or being performed.

I. Toolbar:  The buttons in the Toolbar perform specific actions on the
overview image. Tool buttons include the Scan Frame (Frame) tool, Zoom
(Magnify Glass) tool, Move (Pan) tool, and Pickers tool.

J. Scan Material button:  This shows the type of your scan material – X-ray
(positive films) or Reflective (photos and prints).

K. Scan to button:  This button starts the final scanning process.

L. Minimize button:  Click it to minimize ScanWizard Medi.

M. Exit button:  Click it to close ScanWizard Medi. Take note that when you
exit, you quit from ScanWizard Medi scanning software.
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Preview Area

The preview area is where the overview or prescan image appears after you click
either Smart-Scan (or Auto Scan, Auto Film Feeder), Overview, Prescan, or Scan
to button. This area may appear blank after you perform a scan when you work
on certain scanner models (e.g., Medi-7000, Medi-6000 Plus) .

By the default, the maximum size of the preview area is determined by your
scanner's bed size (or maximum scan area) . You are not allowed to change the
size of the preview area in the X-ray mode. For example, if the scanner's
maximum scan area is 14" x 17", the maximum size of the preview area will be
limited under this dimension.

Preview area

To increase or
decrease the
preview window,
drag the window
to resize
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Scan Material

The Scan Material icon accesses the Scan Material menu. The appearance of the
Scan Material icon changes, depending on whether the scan material is reflective
or X-ray (positive film).

If you are scanning X-ray films, this is the appearance of the Scan
Material icon. When you click the icon and hold down the mouse, you
will see the X-Ray option checked.

If you are scanning reflectives (such as photos or printed materials),
this is the appearance of the Scan Material icon. When you click the
icon and hold down the mouse, you will see the Reflective option
checked.
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Unit of Measurement/Rulers

The rulers on both sides of the preview window assist you in measurement or in
checking the alignment of your image.

The unit of measurement in the ruler can be selected in two ways:  in the Image
Dimension controls located in the Settings window, or by clicking the ruler unit
button at the 0,0 point of the rulers in the Preview window.

Depending on your selection, the rulers can mark off measurement in these
units:  inch, centimeter, millimeter, point, and pixel. The pixel option is dimmed if
the selected resolution unit is lpi, and vice versa.

To select the unit of measurement for the rulers:

Click the unit box in the Settings window, or click the ruler unit button at the 0,0
point of the rulers in the Preview window. When the submenu appears, select
the unit of measurement.
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Smart-Scan (for X-ray mode only)

The Smart-Scan button, a green button, activated only when the software is in
the X-ray mode,  provides you a quick and easy way to perform X-ray film
scanning. With this button applied, the scanner can automatically scan the X-ray
film and deliver the scanned images to your preferred folder or application.

If you are scanning the X-ray films together with a film holder, the Smart-Scan
button will automatically detect the film holder with loaded films, auto-crop the
individual scan frames, and perform scanning in a single pass for all the films  at
one time. The software will scan the images which are the scan jobs checked in
the Scan Job Queue window.

When the “Scan To:  Save As”
dialog box appears, key in a file
name; next, select a type as your
export file format, and  click Save
to perform the final scan. The
available file format includes .tif,
.bmp, .pcx, .jpg, .gif, .pdf, and
more.  “.tif ” is the default.

To view the scanned image, double
click the “MSmart Images” icon on
your desktop (default folder
assigned by the software), or
retrieve it from your assigned
folder.

File Option: This button is active only when the file format is TIF, JPG or PDF;
otherwise it will not appear.

When you select “PDF” as your “Save as type” in the “Scan To: Save As” dialog
box and then click the File Option button, the “PDF Save Options” dialog box
will appear.

• Encoding: The encoding
options include ZIP and
JPEG. If ZIP is selected,
image quality compression
will not be available for
adjustment.
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When “TIF” is selected in the “Scan
To: Save As” dialog box and then
you click the File Option button,
the “TIF Save Options” window will
appear.

• Format::::: Two options are
provided for saving the TIF file.
The options are IBM PC and
Macintosh; default is IBM PC.

• Encoding: : : : : Four options are
provided for file compression.
If “None” is selected, image
quality compression will not be
available for adjustment. The
default is “None”.

Please take note that when you
compress your image, it may affect
your image quality and may result an mis-adjudgement when making a diagnosis.
Therefore, it is not recommended to compress your scanned images when they
have priceless and precious value in medical treatments.

Image after compressed Image without compressed
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Auto Scan (for specific models only)

Point the cursor onto the Smart-Scan button, click and hold the arrow at the
right bottom corner of the button to switch around the option menus. Select
“Auto Scan” from the option menus.

The Auto Scan button is the default button on some scanner models (e.g., Medi-
6000 Plus, Medi-7000) when the ScanWizard Medi is launched.  When this
button becomes visible, the scanner automatically detects and scans the X-ray
film, and later saves the scanned image in a file and delivers it to your preferred
folder or application.

To switch back to the Smart-Scan mode either by clicking the arrow on the
button and selecting the “Smart-Scan” from the option menus or unchecking
“Enable AutoScan”  in the More Preferences dialog box from the Preferences
Menu . For the detail, refer to the later section “Preferences Menu”.

Auto Film Feeder (for specific models only)

Point the cursor onto the Smart-Scan button, click and hold the arrow at the
right bottom corner of the button to switch around the option menus. Select
“Auto Film Feeder” from the option menus.

The Auto Film Feeder button is only available on some scanner models (e.g.,
Medi-6000 Plus) . When this button is activated, the scanner is capable to scan
multiple pieces of  X-ray film through the Auto Film Feeder (AFF), to save the
scanned image in a file, and to deliver them to your preferred folder or
application.
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Overview, Prescan, Scan to

The Overview, Prescan, and Scan to buttons are available only when you are in
the Standard panel of the Preview window. These buttons are particularly useful
when you want to have more controls for the images bofore making the final
scan.

Overview
The Overview button offers a preliminary and low-resolution overview of the
image on the scan bed.  By the default, the entire scan bed is previewed when
you click the Overview button. You are not allowed to change the area size to be
previewed in the Preview window.

Prescan
The Prescan button offers a high-resolution preview image of the area selected
by the scan frame tool. Multiple prescans can be done if you have several
selected scan jobs. The prescans are performed one by one in an order that they
are listed in the Scan Job Queue window.

Scan to
The Scan to button is one of ScanWizard Medi’s great features, which functions
the productivity tools under it. Click and hold the mouse button to activate Scan
to options menu in which you can select Scan to, Copy, or E-mail.

The Scan to button is the default
button when ScanWizard Medi is
launched as a stand-alone
program. It allows to scan the
image on the scan bed and
delivers the scanned images to
your chosen folder or
application.

When the “Scan To:  Save As”
dialog box appears, key in a file
name, then select .tif, .bmp, .pcx,
.dcx, .pdf, or other as the export
file format, and  click Save to
perform the final scan.
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Copy
Click the Scan To button and hold down the mouse until the options menu
appears, then select Copy. A
scan is then performed, and the
scanned image is sent to the
specified printer.

When the “Copy” dialog box
appears, select a default printer
or any alternative printer from
the options. Specify the number
of copies to be made, then click
OK.

E-mail
Click the Scan To button and hold down the mouse until the Options menu
appears, then select E-mail.

When the “E-mail:  Save As” dialog
box appears, key in a file name. It
is recommended that you use
either .jpg or .bmp as the file
format.

Make sure that the check box
“Send image to application after
saving” has been checked. Then
choose your preferred E-mail
application from the options, and
click Save. The saved file can now
be attached to your E-mail message
automatically.
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Toolbar

The Toolbar commands simplify the performance of certain tasks. The Toolbar
commands include Scan Frame (Frame), Zoom (Magnify Glass), Move (Pan), and
Pickers.

Scan Frame (Frame) tool

The Scan Frame tool lets you select the area to be scanned or prescanned. You
can have multiple scan frames, but only one scan frame can be current at a time;
the current scan frame is indicated by a flashing marquee. Multiple scan frames
can be more easily distinguished if you turn on the Smoked Glass Background
command (in the Preferences menu).

Zoom (Magnify Glass) tool

The Zoom tool lets you zoom in (magnify) and zoom out (reduce) your view of
the image. Only your view of the preview image is changed; the actual size of the
image remains unaffected. Each click of the zoom tool magnifies or reduces by a
factor of 2. Thus, the magnification levels increase from 100% to 200%, to
400%, and to the maximum 800%. When you reach the maximum magnification
factor, the center of the Zoom tool will appear empty.

To zoom out (reduce), hold down the Shift key and with the Zoom tool selected,
click the image. A minus sign will be in the middle of the lens to indicate the
image is being zoomed out.

Note:  If the Info window is open, the zoom level will be indicated. This means you can
also zoom in by selecting the appropriate zoom level in the Info window.

Move (Pan) tool

The Move tool lets you scroll through an overview or prescan image, allowing
you to move parts of the image into view quickly without using the scroll bars.
You can use the Move tool for scrolling through zoomed-in images that were
enlarged through the Zoom tool, or for scrolling through parts of an image not
included completely within the frame of the preview window.

Zoom (Magnify Glass)
Move (Pan)

White/Black Point Pickers
Scan Frame (Frame)
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White/Black Point Pickers (for Reflective mode only)

The Picker tools allow you to sample color from a particular area in an image,
and are useful for designating shadow or highlight point.

The White Point Picker ( ) lets you define the whitest reference point in the
preview image. Once you have picked the whitest point, excessive white points
are clipped off.

The Black Point Picker (  ) lets you define the darkest reference point in the
preview image. Once you have picked the darkest point, excessive black points
are clipped off.

With the Picker tools, you can determine the color values for any pixel in an
image. When you click the White/Black Picker and pan over a pixel, the value
for that pixel is displayed in the Info window, based on the sample size selected
in the Info window. Pixel value information is useful especially when you are
making color adjustments based on color value.

To change the sample size of the Picker tool:

1. Open the Info window by choosing the Show Info Window command in the
View menu.

2. Click the Color Meter Options button located to the right of the K values in
the Info window.

3. Choose your options.

Select the sample size options from the drop-down list. For instance, the 1
by 1 option will display the value of one pixel — the pixel in the middle of
the Color Output Meter. The 3 X 3 option reads the average value of a 3-
pixel by 3-pixel area.

To display color information for a pixel or an averaged area:

1. Click the Picker tool.

2. As you pass over a point in the image, observe the Info window — the K
values will be displayed in the Color Output Meter. These values are in turn
based on the sample size you selected.



Microtek ScanWizard Medi Reference Manual     19

The Scanner Menu

The Scanner Menu lets you:

• Show your scanner model or select a scanner if you have multiple scanners

• Get information about current scanner

• Get scanner information on the SCSI/USB/FireWire chain

• Set idle time for saving power

Scanner Model
The scanner model (and its SCSI, USB, or FireWire ID number) is shown at the
top of the scanner. If you have multiple scanners on your system, all the
scanners are shown with their respective IDs, and the current scanner is
indicated by a check.

Only one scanner can be accessed at a time. To switch among various scanners,
select the scanner to be used.

Get Current Scanner Info
This command provides information about your current
scanner. When you choose this command, a dialog box
appears showing the scanner model, Scanner ID
number, and firmware version.

When you are working on some specific scanners  (e.g.,
Medi-7000, Medi-6000 Plus), the dialog box will be
shown as below, where you can get the roller scan times
information.
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Scanner Probe
This command shows the scanner information on your SCSI, USB, or FireWire
chain. If your scanner does not show in the Scanner List dialog box, make sure
your scanner is properly installed, connected, and turned on, and then click the
Probe button. For details on connecting your scanner, refer to your scanner
hardware installation guide.

This information shows you how many scans have been passed through the
roller, which helps out to accumulate the replacement point for the roller. The
recommended replacement point is when the numbers on two sides of the slash
symbol are equal.  Press the Reset button to start recounting the scans for the
roller after replacing a new one.

Scanner Control (Power Saving Control)
The power-saving feature of the scanner lamp to save energy and extend the life
cycle of the lamp. By default, the lamp turns off automatically if the scanner is
idle for 15 minutes. You can change the lamp idle time in your preferences or
disable this feature completely by unchecking the Auto Power Saving Mode check
box.

Note:  Not all scanner models support these features. If your scanner model is not
supported, the Scanner Controls command will be grayed out in the Scanner menu.
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The View Menu

The View menu lets you:

• Resize the Preview window

• Show/hide the Information and Scan Job Queue window

• Show/hide Status Bar

Overview Image/Prescan Image
These commands allow you to switch between Overview or Prescan viewing
modes.

• Overview image:  This is an image obtained when you click the Smart-Scan
button (X-ray mode) or the Overview button (Reflective) in the Preview
window. The image shows you whatever is on your scan bed.

The Overview image is always checked automatically whenever you launch
the ScanWizard Medi.

• Prescan image:  This is a detailed image obtained from selecting an area in the
Overview image and then clicking the Prescan button (Reflective mode) in
the Preview window.

The Prescan image is available only for viewing when you are in Reflective
mode.

Click the Prescan button. The Prescan image
will then be available for viewing in the View
menu, and a " " thumbnail will appear in the
Scan Job Queue window.
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Resize Window to Fit
This command resizes the Preview window, which you may find helpful to do for
conserving space on your desktop monitor (especially after you have enlarged
the Preview window).

Bring Settings Window to Front
This command brings the Settings window to the forefront, which is useful if you
have the Settings window hidden behind other windows or if you have expanded
your Preview window such that it hides the Settings window in the background.

Show/Hide ...Window commands
These commands allow you to switch between showing or hiding the Scan Job
Queue window, Information window, and Status bar on your screen.

To use this feature, choose the correct command from the View menu for
viewing a window. When the window appears, you can hide it by choosing the
particular Hide command for it.

Overview viewing mode Prescan viewing mode

Untitled1
Prescan Image

Untitled 2
Prescan Image
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The Preferences Menu

The Preferences menu lets you:

• Choose the correct scan material

• Set up White/black point parameters

• Show/hide auxiliary cursor lines

• Fine-tune monitor gamma values

• Create the invert effect

• Activate the smoked glass effect

• Set other options, such as specifying a working directory for files

Scan Material
This command allows you to select the correct scan material. Scan materials can
be classified into two types:

• X-Ray films, such as dental films, mammography films or other medical X-ray
films.

• Reflectives, such as medical reports, study reports, or prints.

The default scan material is X-Ray film (positive film) no matter what scanner
model you are using. The choices available in the Scan Material submenu will
depend on your scanner. When you are using some specific scanner models
(e.g., Medi-7000), the X-Ray option will be the only choice.

If you are scanning reflective materials, make sure that you switch to Reflective
mode, or you will get inaccurate scanning results.
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To choose your scan material:

• Choose the Scan Material command in the Preferences menu. From the
submenu that appears, select your scan material; a check will appear next to
the selected option.

• Alternatively, you can click the Scan Material button and then choose the
correct scan material from the drop-down menu that appears.

White/Black Points Setup
This command provides you with advanced controls for setting the clipping
points for your white and black points, as well as determining the output levels
for the white/black points on your printer.

To use this feature:

1. Choose the White/Black Points Setup command from the Preferences menu.

2. As an alternative, you can click this command from the Color Correction
Menu. This is also the same thing as clicking the White/Black points tool in
the Settings window and then clicking the Setup button from the dialog box
that comes up. When the dialog box comes up, specify your preferences.
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Auto White Point Clipping/Auto Black Point Clipping

The Auto White Point Clipping and Auto Black Point Clipping fields allow you to
specify the percentage by which the white and black points, respectively, can be
clipped from the histogram. The clipping is done after you click the Auto button
in the AIC White/Black Points dialog box.

For example, if you specify 10 percent as your White Point clipping value and
then click the Auto button, the white point on the histogram is adjusted so that
10 percent of the color information is “clipped” or ignored. The resulting 90
percent information leftover is then remapped, resulting in an image with less
highlight detail.

The same principle above applies to the Auto Black Point Clipping feature, which
governs the black point for shadows.

Minimum Output Level/Maximum Output Level

The Minimum Output Level lets you set the minimum output level of the black
point. The higher the percentage value, the lower the contrast will be.

The Maximum Output Level lets you set the output level of the white point. The
lower the percentage value, the lower the contrast will be.
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Cursor Auxiliary Lines
This command allows you to show or hide cursor auxiliary lines to help you
define a scan frame or measurement off the rulers more precisely. Using the
cursor auxiliary lines, you can also read the measurements of your ruler more
easily.

Cursor auxiliary lines (black
dotted line) on the x and y axis

To use this feature:

1. Choose the Cursor Auxiliary Lines command in the Preferences menu.
From the submenu that appears, select how the cursor lines will appear.

• On both x (horizontal) and y (vertical) axes
• On x axis only
• On y axis only
• None (no cursor lines)

2. Click the Scan Frame tool.

To see how the cursor auxiliary lines work, draw a scan frame. Click on the
top left corner of the image as your starting point, then drag down
diagonally to form a scan frame. As you draw the scan frame, cursor lines
will appear to help you draw the scan frame precisely. When you release the
mouse, your scan frame will be aligned with the cursor lines.

Scan frame
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Monitor Gamma Setup
The Monitor Gamma Setup command lets you compensate for the linear
intensity of the monitor, allowing for consistency between the preview image
and the final scanned image.

Monitor Gamma

Check this box to enable monitor gamma value setting. When the monitor
gamma option is checked, click the up/down arrow buttons to make the gray
level of the boxes as close as possible. Click OK to confirm.

Invert
This command creates a negative effect to an image. The Invert effect is applied
to all scan jobs, not just the selected scan job.

When an image is inverted, the brightness value of each pixel is converted to its
inverse value. In the case of 12-bit image, for example, a pixel in a positive image
with a value of 255 is changed to 0, and a pixel with a value of 5 is changed to
250.
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More... command
The More... command shows the More Preferences dialog box, where you can
specify other options for ScanWizard Medi.

Keep Overview Image

If checked, the image that is scanned in the Overview or Smart-Scan command
remains on the screen until the next image is acquisition is performed. If
unchecked, the overview image is deleted when you exit ScanWizard Medi.

Keep All Prescan Images

If checked, the image that is scanned in the Prescan command remains on the
screen until the next image is acquisition is performed. If unchecked, the
prescan image is deleted when you exit ScanWizard Medi.

Confirmation Message

If checked, a confirmation message appears when image effects such as Rotate
or Flip are applied. If unchecked, no confirmation message appears.

Smoked Glass Background

This option lets you apply a smoked glass background that makes your scan jobs
stand out more clearly and allows you to focus on the scan jobs. This feature can
also be used for multiple scan jobs to show their respective image modes, as well
as their image editing settings.

The framed part of the image (inside
the marquee) stands out clearly.

Applied to the rest of the image is
the smoked glass background
(shaded gray area surrounding the
selection or framed area).
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Scan Quality

This option allows you to select the image quality by controlling the scanner
hardware and the maximum image processing depth.

Speed: Choose this option if your primary concern during scanning is
speed. Image data is delivered faster and the image data is
processed in 8 bits per channel.

Quality: This is the default setting. Scanned data is delivered a little
slower but in high quality, and the image data is processed in 8
bits per channel.

Best Quality: This setting is available only to higher-depth scanners (10-, 12-
bit, or higher). Scanned data is delivered a little slower but in
high quality, and image data is processed in maximum bits per
channel (i.e., 10-, 12-bit, or higher), and then converted to the
desired output depth. This special operation results in the best
image quality possible.

Working Directory

This lets you specify a place to store temporary working files (e.g., scan job files)
during a scanning session. If the directory you specify is not found or does not
exist, a warning message appears, and ScanWizard Medi will create one
automatically for you.

If the computer is shared by several users, each user may specify a particular
working directory to use.

The working directory is the folder where ScanWizard Medi creates temporary
files, with the temporary files deleted at the end of an operation. You should
change to a different folder only if the working directory is located in a disk
volume that is too small for scanning operations. To specify a new working
directory, click the yellow folder beside this option, and assign a new directory
to use.

Auto Background Correction (for Reflective mode only)

This option enables you to bring out and improve readability of text in a
document that includes other elements such as pictures or graphs.

Enable Auto Scan (for specific models only)

This option enables you to activate or turn off the auto scan function. For the
models supporting the auto scan function, this option is checked by default. If
this option is uncheked, the Auto Scan button in the Preview widow will become
the Smart-Scan button and carry those functions supported when the Smart-
Scan button is activated.
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The Correction Menu

The Correction Menu lets you use the Advanced Image Correction (AIC)
features of ScanWizard Medi. The commands in the Correction menu
correspond to the AIC buttons in the Settings window.

For more information, see the section of the manual on Advanced Image
Correction

The Help Menu

The Help menu lets you access on-line help for ScanWizard Medi, and gives you
information on the ScanWizard Medi scanning software.

About
This command displays the ScanWizard Medi splash screen and shows the
program’s version number.
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The Settings Window

The Settings window contains the parameters for outputting your scanned image
for the current scan job and includes the advanced image correction tools of the
program.

Elements of the Settings window
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Clicking the
Window
Expansion button
to expand  the
Settings window.
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A. Scan Job:  This shows the current scan job as indicated by the Scan
Job Queue window and by the selected image in the Preview window.

B. Type:  This shows the image type of the current scan job.

C. Resolution settings:  This area includes the following:  the Resolution
box for specifying your output resolution; the Resolution list box
(with the arrow button) that provides predefined resolution values
for easier selection of the resolution setting; and the Resolution unit,
which lets you choose from ppi and several lpi options.

D. Scan Frame options:  This area includes the Scan Frame settings
which represent the dimensions of the image that you wish to scan;
the Scaling factor for creating larger or smaller images from the
original source image; and the Output settings, which represent the
dimensions of the image when it is output.

E. Image size:  This shows the size of the file when the image is scanned.

F: Multiple Sampling:  This lets you reduce the random noise of the
scanned image.

G. Window Expansion button:  This reveals the half bottom of the
Settings window, including various Image-correction controls.

H. Reset button:  This button lets specify which settings in the Advanced
Image Correction (AIC) controls to be restored to their default
values.

I. Unit of measurement:  This lets you chose your desired unit of
measurement, which will then be reflected in the rulers along side
the Preview window. Choose from inch, cm, mm, point, pica, or pixel.

J. Transform:  This lets you flip the image horizontally or rotate the
image in increments of 90 degrees. This appears only when you are
prompted to perform the film scan without film holder.

K. Advanced Image Correction (AIC):  The Advanced Image Correction
(AIC) tools let you adjust and enhance the image, and image
corrections are displayed in real time. The AIC tools available for use
will vary, depending on the scan material chosen in the Preview
window.
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Scan Job

The Scan Job box shows the currently selected scan job, which is also shown in
the Scan Job Queue window and the Preview window.

There is always at least one scan job in existence (by default). If you have
multiple scan jobs, not only are these reflected as multiple entries in the Scan Job
Queue window and as multiple images in the Preview window, they will also be
shown as multiple entries in the Scan Job box of the Settings window.

To select from multiple scan jobs, choose the scan job you wish in the Scan Job
box; this will automatically select the corresponding scan job in the Preview and
Scan Job Queue windows as well. Conversely, selecting a scan job in either the
Preview or Scan Job Queue window will automatically show that selection in the
Job box.

This means that a quick look at the Scan Job box, the Preview Window, or the
Scan Job Queue window can show you which is your currently selected scan
job.

Correspondence between the Scan
Job box in the Settings window and
the current scan job in the Preview
and Scan Job Queue windows
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Image Type

The Type menu determines what your resulting scan will be. It does not refer to
the original image type. ScanWizard Medi allows a direct scanning in either of
Gray Scale, Gray Scale (12-bit), or Gray Scale (16-bit) color spaces.

The default image type depends upon the scanner you are using, and the choices
available to you in the Type box will also depend on your scanner.

To choose your image type, click the arrow button next to the Type box, and
choose your setting from the list box.
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Resolution Settings

Resolution is the sampling of image pixels per measurement unit or the amount
of pixel information stored in an image. Together, the image resolution and
dimensions determine the file size of the image, which is measured in kilobytes
(KB) or megabytes (MB).

The resolution of an image is important in determining the quality of the output
image. Resolution is also directly related to file size, and the higher the
resolution, the larger the resulting file size will be.

When dealing with resolution, remember to distinguish between optical
resolution and interpolated resolution.

Optical resolution is the “real” resolution as measured by the scanner’s optics.
Interpolated resolution is software-enhanced resolution and can be useful for
enlarging very small images or for printing line art to obtain superior results.

Resolution List Box

This provides predefined resolution values for easier selection of the resolution
setting.

The default resolution depends upon the scanner you are using, and the choices
available to you in the resolution list box will also depend on your scanner. After
you select your resolution value, this value is then recorded for subsequent use,
until a new value is selected and takes over.

To choose your resolution, click the arrow button next to the Resolution box,
and choose your setting from the list box.
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Resolution Unit

The unit of measurement for resolution is in ppi (pixels per inch) or lpi (lines per
inch). Take note that lpi settings are dimmed if the ruler unit is in pixels.

To choose your resolution unit, click the arrow button next to the box, and
choose your setting from the list box.

• Choose ppi if your scanned images are intended for on-screen display. In this
case, you need not go higher than the target resolution of your monitor. A
higher resolution value will simply increase the file size of your image
without any perceptive improvement in image quality.

• Choose lpi if your scanned images are to be printed. If you choose 1x, for
instance, your scanned image will be printed at 133 lines per inch, resulting
in a 133-dpi image. At 1.5x, the image will be printed at 199.5 dpi; and at 2x,
the image will be printed at 266 dpi. The Custom option allows you to set an
lpi value of your own specification.

In choosing an appropriate lpi value, keep in mind that if the resolution is too
low, the image becomes pixelized, resulting in a deterioration of image quality.
(Pixelization is the process in which the Postscript language uses a single pixel’s
color values to create more than one halftone dot.) Conversely, if the resolution
is too high, the file size becomes unwieldy, and y our file ends up containing
more information than the printer needs, slowing down the file transfer and the
printing process.
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Scan Frame and Related Settings

These settings allow you to adjust the various factors that affect your image,
including the width and height of your image when it is first scanned (Scan
Frame settings), the Scaling factor (how big or how small the resulting scanned
image will be), and the dimensions of the image when it is output (Output
settings).

To choose the scaling percentage, click the
arrow button next to the Scaling box, and
choose your setting from the list box.

Scan Frame Settings

The Scan Frame settings (width and height) represent the area on the scan bed
that you wish to scan.

To specify your settings, enter the dimensions manually in the width and height
edit boxes; or use the Scan Frame tool to define or resize your scan frame.
Changes made in the Preview window are automatically displayed in the Scan
Frame setting edit boxes.

Scaling

Scaling lets you create larger or smaller images from the original source image.
Take note of the following:

• Keep the scaling at 100% if you are outputting at the same size (e.g., a 14” x
17” original to be output at the same size).

• Reduce the scaling if you are outputting your image at a smaller size (e.g., a
9” x 7” original to be output to 4.5” x 3.5”). Increase the scaling if
outputting at a larger size.
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Output Settings

The Output settings (width and height) represent the dimensions of the image
when it is output (to either monitor or printer). If the size of the image to be
output is different from the size of the original image, adjust the scaling
percentage, or manually increase/decrease the output values accordingly.

Image Size

The Image Size field indicates how big the file will be when you accept the
dimensions shown in the edit boxes, together with the resolution setting that you
have selected. Size is calculated automatically. The resulting file size depends on
the image type; resolution; and dimensions of the image.

Unit of Measurement

The unit of measurement lets you select the desired unit (inch, cm, mm, point,
pixel, pica) for your image dimensions.

To choose the ruler unit, click the arrow button next to the box, and choose
your setting from the list box.
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Multiple Sampling

The Multiple Sampling function is a process in which the scanner samples each
line in the image a number of times, then obtains an average to reduce random
noise. Enabling multiple sampling will slow down scanning, as the process
requires extra time to yield higher-quality images.

To choose your setting, click the arrow button next to the Multiple Sampling
box, and choose your setting from the list box.
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Transform

The Transform function allows you to rotate and/or flip the image in increments
of 90 degrees. The effects of the Transform function will only be applied to the
scanned image after you click the Scan button; the Transform effect is not
applied to the Overview image.

The Transform function appears only when you are scanning the X-ray film with
the film holder. However, if the scanner cannot detect the holder during the
scanning process, you will be asked to perform the scan without film holder
from a prompt dialog box and simultaneously the Transform button will also
show in the Settings window.

Transform

If you want to continue the scan without using film holders, click the Transform
button to choose a desired option setting. Then, click the Scan button in the
prompt dialog box to continue your scan. When the image is scanned, it will be
rotated or transformed according to the selected option.



Microtek ScanWizard Medi Reference Manual     41

The Reset button

The Reset button in the Settings window brings up a dialog box where you can
specify the AIC settings to be reset to their default values. To reset any or a
combination of settings, check the boxes next to the targeted settings.
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Advanced Image Correction Tools

The Advanced Image Correction (AIC) tools form an integral part of ScanWizard
Medi. With the AIC tools, you can adjust or enhance images right from within
ScanWizard Medi and preview the changes to your image even before you scan.

Click the Window Expansion button     to reveal the half bottom of the Settings
window. The various AIC tools available for use will be shown depending on the
Scan Material chosen in the Preview window.

The following topics are covered:

• How to access the AIC tools

• Elements of the AIC dialog box

• The Action buttons

• Using Custom Settings

• Discussion of the individual AIC tools

For X-ray mode only For Reflective mode only

 Window
Expansion button
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Accessing the AIC Tools

1. To access an AIC tool, click a particular tool in the Settings window or
choose its counterpart in the Correction menu in the Preview window.

2. After clicking a tool, the AIC dialog box appears. The elements of the AIC
dialog box are explained in the next section.
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Elements of the AIC Dialog Box

A. Left thumbnail

This shows the image before enhancements are applied.

B. Right thumbnail

This shows the image after enhancements are applied.

C. 1:1 Thumbnails

If checked, the size of the thumbnail is about the same as the image shown in the
Preview window. If unchecked, the image size appears fit into the shown dialog
box.

D. Hide Thumbnails

If checked, the “before” and “after” thumbnails becomes hidden. The screen
collapses to show only the lower portion of the dialog box. To restore the
screen, click the “up” arrow at the left side of the dialog box.

E. Preview option

If checked, changes are applied immediately to the Preview window image. If
unchecked, changes are seen only after you close the AIC dialog box.

A B

E

I

D

F

G

11

H

C

J



Microtek ScanWizard Medi Reference Manual     45

F. Function icons

These icons (e.g., eyedropper, lens, etc.) perform functions specific to the AIC
tool being used. Function icons are explained in more detail under their
corresponding AIC tool.

G. Action buttons

These carry out a specific action. See the next section for more details.

H. Add To Menu button

This button allows you to save a custom setting for an AIC tool. You may retrieve
this custom setting afterwards from the Setting windows.

I. AIC tools

These tools adjust or enhance your images. Click any tool in this area, and see
how the core of the AIC screen (#K) changes to reflect the properties of that
tool.

J. Arrow button:

This allows you hide/show the thumbnails.

K. Core of the AIC screen

This is the heart of the AIC screen, and the content here changes to reflect your
selected AIC tool.
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The Action Buttons

The Action buttons in the AIC dialog box let you accept, cancel, or control the
application of AIC settings.

OK button

This button applies to the current scan job whatever image corrections you have
performed, and then closes the AIC dialog box.

Cancel button

This button cancels out all image correction changes you have made to the
current scan job, and then closes the AIC dialog box. The settings remained
unchanged

Reset button

This button brings up the Reset dialog box, where you
can specify which settings are to be restored to their
default values, then click Reset or Cancel.

If Reset is selected, the settings are restored to their
default values; if Cancel is selected, the operation has
no effect.

Revert button

This button to cancel out the changes that were made with the current image
correction tool. This means that if you used several AIC tools, Revert cancels the
effect of only the last used (or current) tool, and preserves the effects of the
other preceding tools.
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Custom Settings

When you click on each AIC setting in the Settings window, a drop-down menu
will show options for adding, removing, or loading custom settings. These
custom settings are settings that you define yourself for your scan jobs.

For instance, if you wish to change the shadow to an image and then save that
shadow setting for future scan jobs, you can add the shadow setting as a custom
setting. The next time you wish to retrieve that particular shadow setting, simply
go to the White/Black Point AIC drop-down menu, and choose that setting.

Adding Custom Settings

To add a custom setting for an AIC tool, click the Custom...in that tool’s pop-up
menu, or click the Add To Menu ... button in that tool's dialog box. When a dialog
box comes up, enter the name of the new custom setting to be added. For
instance, the added setting can be called “mammo” as shown below.

A user-defined setting that has been added
and can now be retrieved

Lets you add or remove from the menu
settings you have previously defined
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Removing Custom Settings

To remove a custom setting for an AIC tool, click the Remove Settings... in that
tool’s pop-up menu. When a dialog box comes up, select the particular setting to
be removed, then click Remove and Done in the dialog box.

Loading/Retrieving Custom Settings

To load or retrieve a custom setting that you have previously defined for an AIC
tool, go to that AIC tool’s pop-up menu, and choose the setting you wish to be
loaded.

Custom setting to be retrieved
or loaded
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White/Black Points

The White/Black Points tool is used to change the shadow and highlight points
of an image.

By using this tool, you can manipulate an image to either bring out the highlights
in a very dark image, or bring out more of the shadows in a very light image. The
White/Black Points tool can also be used to neutralize the color cast in the
highlight and shadow regions.

A.  Histogram

The histogram is a graphic representation of how all the pixels in an image are
distributed across brightness and darkness levels. The darkest pixels are at the
left; the lightest pixels are at the right.

A histogram skewed heavily to the left indicates that the image has many more
dark pixels than light. Conversely, a histogram skewed heavily to the right will
indicate a light image as it has more light pixels than dark. The height of the
histogram indicates the number of pixels at that point in the histogram.

B.  Sliders

The sliders are used to adjust the Black and White points of the image. The
values of the black and white points are reflected in the edit boxes below.
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C.  Channel

The channel allows you to control the shadow and highlight settings for Gray
channel.

D.  Input, Count, Percent

These figures provide information about the histogram. The figures will appear
only when the cursor is on the histogram or if a slider is being moved.

• The Input value indicates the color value of the data displayed in the
histogram.

• The Count value indicates the number of pixels at the Input value. If Input
value is 2 and Count value is 1300, then there are 1300 pixels in the image
at the Input value of 2.

• The Percent value is the percentage of all pixels in the image where color
value is less than or equal to the input value. For example, if Percent is 15%
and Input value is 2, it means that 15% of all pixels in the image have a value
of 2 or less.

E.  The Setup button

This button provides you with advanced controls for setting the clipping points
for your white/black points, as well as determining the output levels for the
white/black points on your printer.

Click to bring up the White/Black points setup dialog box. For more details, see
the section titled White/Black Points Setup (under the Preferences menu in the
Preview window).

F.  Pickers

The Pickers can be used instead of the sliders to set the Black and White points,
based on color values in the preview image. The Picker on the left sets the Black
point; the Picker on the right sets the White point.

• To set the White point:  Click the Picker on the right, then click on the
preview image to define the reference point.

• To set the Black point:  Click the Picker on the left, then click on the
preview image to define the reference point.
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G.  Auto button

The Auto button automatically judges the darkest and whitest points and clips
excessive black or white points. The clipping percentage of the white/black
points is accessible by clicking the Setup button.

Using the White/Black Point tool:

1. Choose the Channel in which the histogram will be modified.

2. Move the black and white sliders to new points on the histogram.

• Moving the black slider to the right will yield more contrast in the
highlight areas of the image, so that more detail emerges in the highlight
areas.

• Moving the white slider to the left will yield more contrast in the
shadow areas of the image, so that more detail emerges in the shadow
areas.

Another alternative is to simply click the Auto button, so that the
shadow and highlight for the image is determined automatically.

3. When the changes are done, click OK.

 For more details on the effects of the other action buttons, see the section
“The Action Buttons”.
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Tone Curve

The Tone Curve tool lets you adjust the tonal range of an image. However,
instead of making adjustments using just three variables (highlights, shadows,
and midtones), you can adjust any point along the 0-to-255 scale (for 8-bit
images; 0-to 4096 scale for 12-bit images).
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How to Read the Curve

The Curve shows the relationship of the brightness changes across the middle
pixels between the resulting image and the original. When you open the Curves
dialog box, the line on the graph is diagonal because the Input and Output
values are the same.

When the curve is moved up or down, the relationship between input value and
output value changes accordingly.

F
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• In areas where the curve is
moved down, pixels in that
portion of the image are
darkened.

Contrast in an image can be seen by the angle of the line. The steeper the slope,
the higher the contrast. The closer the line is to horizontal, the lower the
contrast.

A.  Curve

The Curve is a graphic representation of the tone curve showing scanner input
from dark on the left to light on the right.

B.  Method

The Method sets the kind of curve you wish to have. Select from Line, Curve, or
Gamma.

       

C.  Channel

The Channel allows you to choose the gray channel only in which the gamma
will be affected.

• In areas where the curve is
moved up, pixels in that
portion of the image are
lightened.
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D.  Input, Output, Zoom:

• Input shows the horizontal value of wherever the cursor is inside the curve,
reflecting the scanner’s full depth.

• Output shows the vertical value of wherever the cursor is inside the curve,
reflecting the scanner’s full depth.

• Zoom indicates the magnification level of the curve box. At 100% zoom, the
curve is seen in its entirety. Using the zoom frame tool to magnify the curve
will zoom in or enlarge your view of the curve, resulting in a higher zoom
percentage.

E.  The Curve Tools

The Curve Tools let you modify the curve. The tools are the curve pointer, the
curve zoom frame, and the curve pane.

Use the Curve Pointer tool to define points in the curve that will be
modified. When you click on any point in the curve, a black handle
appears to mark your position. To remove the handle, drag it off
the graph.

Use the Curve Zoom Frame tool to zoom in and out on a particular
point in the curve. Once the area is zoomed in, you can then use
the Curve Pointer tool to define new points for better precision.
This is particularly useful for working with 12-bit images, where
more detail can be seen in such images. The zoom level can be seen
in the Zoom field. To zoom out, click Shift.

Use the Curve Pane tool to scroll through the curve if the curve
has been zoomed in. This curve tool can be used only if the curve
has been zoomed in with the Curve Zoom Frame button (above).
Otherwise, the Curve Pane tool will be dimmed.

F.  The Save As button

The Save button lets you save a tone curve together with its settings so that the
curve can be used in the future if necessary.

G.  The Load button

The Load button lets you load a previously saved tone curve for use with
another image. Photoshop-saved curves can also be loaded.
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Using the Tone Curve tool:

1. Choose the Channel in which the curve will be modified.

2. Choose the Method in which the curve will be modified. Select from Line,
Curve, or Gamma.

3. Click the Curve Pointer tool, then click on the curve to define the points
where the curve will be modified. You can then either raise or lower the
curve at that point and see changes to the image accordingly.

4. When the changes are done, click OK.

For more details on the effects of the other action buttons, see the section
“The Action Buttons”.

5. To save a curve, click the Save As button. To load a previously saved curve,
click the Load button and specify the curve setting to be loaded.
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Brightness and Contrast

The Brightness & Contrast tool lets you control the brightness and contrast
levels of the entire image. Increasing the brightness makes all tones in the image
lighter. Contrast, on the other hand, is the range between the darkest and
lightest shades in the image, and increasing the contrast makes greater
separation between the darkest and lightest areas of the image.

• Brightness:  The Brightness control lets you change the brightness setting.
Too much brightness can make an image look washed out, while too little
brightness will make the image look dark.

• Contrast:  The Contrast control lets you change the contrast setting. Too
much contrast will make an image look like a photocopy of a picture, with
little or no gray shades left. Too little contrast will make the colors in the
image look dull and flat.

Drag the sliders
or enter values to
change
Brightness and
Contrast
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Filters

The Filter tool is used to apply special effects to your images. Several filters are
provided in ScanWizard Medi, including Blur, Blur More, Edge Enhancement,
Emboss, Unsharp Masking, Sharpen Low, Sharpen Medium, and Sharpen High.

In using most of the Filters (except Unsharp Masking), the image you obtain in
the preview window may differ from the way the image appears when you finally
scan it in. For the Unsharp Masking filter, the final scan result can be simulated
and previewed, either from the thumbnail on the filters dialog box or from the
preview image in the Preview window.

Keep in mind too that the appearance of the image in the preview window and
how it is affected by a filter will depend on the resolution of the image. The
higher the resolution, the less obvious the effect of certain filters (such as Blur).

Click the arrow button
next to the Filter box,
and choose the filter
you want from the list
box
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Blur/Blur More

The Blur filters eliminate noise in the parts of the image where significant color
transitions occur. These filters decrease the contrast between adjacent pixels,
making the image appear hazy and out of focus.

• Blur smooths out the transitions by lightening pixels next to the hard edges
of defined lines and shaded areas.

• Blur More produces an effect three or four times stronger than Blur.

Edge Enhancement

The Edge Enhancement filter gives greater contrast to edges. The filter can do
this because edges are areas in an image where gray or color levels change
abruptly. It is best to use this tool for improving geometrical, contoured shapes.

Emboss

The Emboss filter makes a selection appear raised or stamped by suppressing
the color within the selection and then tracing its edges with black.

Sharpen Low/Sharpen Medium/Sharpen High

The Sharpen filters do the opposite of the Blur filters and increase the contrast
of adjacent pixels, making images appear sharper and more focused.

The three sharpening filters (Sharpen Low, Sharpen Medium, and Sharpen High)
improve clarity. The Sharpen High filter has a greater sharpening effect than the
Sharpen Medium filter, which in turn has a greater sharpening effect than the
Sharpen Low filter.

Unsharp Masking

The Unsharp masking filter is used to adjust the contrast of edge detail, creating
the illusion of more image sharpness. This filter can be useful for refocusing an
image that has become blurry from interpolation or scanning, and it is an
essential tool for doing CMYK color separation. In general, Unsharp masking is
needed to render sharp color reproductions, especially when you wish to make
a large color reproduction from a small original.
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Using the Unsharp Masking:

From the settings window, click the Filter tool button, then choose Unsharp
Masking from the list of options.

1. Click the Filter tool button to open the AIC window. The Unsharp Masking
dialog box appears.

2. Enter a value in the Strength box to specify the degree of the filter’s effect.
The higher the value, the stronger the effect of the filter.

3. Select a mask size in the Mask Size box. This parameter determines the
depth of pixels that will be affected at the edge. Available selections are 3x3,
5x5, 7x7, 9x9, 11x11, and 13x13. For small, low-resolution image files, 3x3
is sufficient. For high-resolution, or large-scale image files, use 7x7.

4. Enter a value in the Threshold box. This option allows you to specify a
tolerance range to prevent overall sharpening that might generate noise or
cause other unexpected results. The Threshold defines the required image
of contrast between adjacent pixels before sharpening is applied to an edge.
A lower value produces a clearer effect.

5. The Light and Dark option control the sharpness effect to be applied to the
light and dark edges of the images, respectively. In general, doing too much
Unsharp Masking on light edges would make images seem unnatural, as the
human eye is sensitive in perceiving changes in bright areas of the image
beyond a certain threshold. If both values are 0, Unsharp Masking effect is
disabled.

6. Click OK to apply the settings.

Normal Blur More Edge Enhancement

Emboss Sharpen High Unsharp Masking
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Density (for X-ray mode only)

Image density is measured from image brightness with optical densitometers.
Optical density range determines difference between lightest and darkest colors
which optical sensor is capable to recognize.  The minimum and maximum
values of density capable of being captured by a specific scanner are called
Dmin (minimum density, lightest tone)  and Dmax (maximum density, darkest
tone). If the scanner's Dmin were 0.2 and Dmax were 4.2, its dynamic range
would be 4.0. Dmax implies unique image tone values are distinguishable, and
not hidden by electronic noise. Great dynamic range can detect greater image
detail in dark shadow areas of the image, because the range is extended at the
black end.

Therefore, the value of density is directly related to image quality. The higher
value of density, the more light the image will be.

None

None of the density settings will take effect to the image.

Automatic

This automatically optimizes the density capture range of the image by making
adjustments to the Dmin and Dmax values of an optimized range.

Using the Density,

Click the arrow button next to the Density box, and choose your setting from
the list box.

Note:  The Density function is available only in the Settings window when the connected
scanner is supported by this function (e.g., Medi-3200, Medi-7000).
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Exposure Time (for X-ray mode only)

The Exposure Time tool allows you to perform the exposure correction for the
current scan job. This function tries to average the intensity of the image and to
compensate for a very dark image, making  the dark areas of the image much
brighter.

Custom...

This allows you specify a custom setting for the Exposure Time to your image.

Automatic

This allows you correct the image with automatic exposure. If checked, the
slider bar will be disabled on the screen.

Using the Exposure Time,

1. In the Settings window,  click the arrow button next to the Exposure Time
box, and choose “Custom...” to enable its slide bar under it.

2. Point your mouse to the slider bar, then adjust slider bar to increase/
decrease the value of a user setting.

The value of the exposure is reflected by the slider bar after you made
adjustment. A high exposure value will extend scanning processing time, for
it requires extra time to produce a better visible image.

Note:  The Exposure Time function is available only in the Settings window when the
connected scanner is supported by this function (e.g., Medi-3200, Medi-7000).

The choices available in the Exposure
Time box will depend on the scanner
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Descreen (for Reflective mode only)

The Descreen tool lets you remove moiré patterns in the scan process. Moirés
occur when you scan a screened original (mostly reflective materials, such as
pictures from a newspaper or magazine). These patterns appear to the naked
eye like a series of grids or dots, as shown in the example below.

Using the Descreen:

1. Click the Descreen drop-down menu in the Settings window.

2. When the Descreen menu comes up, select the screen for your needs, or
choose Custom to set your own descreen options.

When the Descreen dialog box comes up, enter a value that best
corresponds to the dot quality of the original in which the moiré is to be
removed. You may use a screen finder to measure the print screen lpi.
Please contact your local print shop for more information on how to obtain
a screen finder.

• Set a value from 50 to 85 if the original image has a coarse dot pattern,
as in images taken from a newspaper.

• Set a value from 100 to 133 if the original image has a fine dot pattern,
as in images taken from a magazine.

• Set a value from 200 to 250 if the original image has a very fine dot
pattern with a near-photographic quality, as in images taken from a
high-quality art magazine.
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Automatic Color Restoration (for Reflective mode only)

The Automatic Color Restoration feature allows the scanner restores faded
colors in photos, bringing hues back to their original luster and brilliance for
more vibrant images. With one-click, automatic color recovery process is simple
and straightforward, involving no learning curve or hassle.

To use the Automatic Color Restoration function:

1. In the Preview window of the Advanced Control Panel, marquee the faded
image area to be restored.

2. In the Settings window, check the “Automatic Color Restoration” option.

3. Click the “Scan To” button to perform scanning. Automatic Color
Restoration is applied, and faded colors in the photo are restored.
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B. Mouse Cursor
Position

D. Sample Display Area

E. Color Meter Options

C. Color Output Meter

A. Zoom Level Display

 Elements of the Information window

The Information Window

The Information window displays color information as you move the cursor
over the preview image in the Preview window (or the thumbnail in the
Advanced Image Correction dialog box if it is open).

You can choose to show or hide the Information window in ScanWizard Medi.
To do this, click the Show/Hide Info window toggle command under the View
menu in the Preview window.

Clicking the Window
Expansion button to
expand  the Information
window.
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A. Zoom Level Display

The Zoom Level Display magnifies your view of an image, much like the Zoom
(Magnify Glass) tool in the Preview window.

The magnification factor in Zoom Level Display is by a factor of 2. Thus, the
magnification levels increase from 100% to 200%, to 400%, to 800%.

To use the Zoom Level Display, click the Zoom  box to choose a
zoom or magnification level you wish to use from the drop-
down menu that appears.

B. Mouse Cursor Position

The Mouse Cursor Position (Pixel Position) shows you the cursor position on the
x (horizontal) and y (vertical) coordinates of the axis. This feature is useful for
operations that require very precise measurements and alignment.

C. Color Output Meter

The Color Output Meter is useful if you wish to adjust the shadow and highlight
points of an image.

As you move the cursor over a point in the image, the Color Output Meter will
show the appropriate K values of that point in the image. The significance of the
numbers is explained below.

• There are two numbers shown in the Color Output Meter. The first number
represents the raw color data taken by the scanner; the second number
represents the resulting value after color correction or image enhancement
is applied to the image.

• The values can be anywhere from 0 to 255, with 0 as the black point, 255 as
pure white, and all other values in between corresponding to shades of
varying degrees between black and white.

• The values as a whole represent color info for the sample size selected in
the Color Meter Options button. For instance, if you chose 3 x 3 as your
sample size and your K value reads 23, that shows your K value of 23 is the
average of a 3-pixel by 3-pixel area.

Pixel-value info is useful especially if you are making color corrections based on
color values. Knowing this, you can modify the shadow and highlight points of
an image, then come back to the same point in the image, and verify through the
Color Output Meter that the K values have indeed changed.



66     Microtek ScanWizard Medi Reference Manual

D. Sample Display Area

This shows a pixelized display of the area surrounding the cursor. The size of the
sample area depends on the selection made in the Color Meter Options.

E. Color Meter Options

These options let you choose how color information is displayed — in numbers
or percentages.

To use the Color Meter Options, click the Color Meter Options button to choose
your  setting from the drop-down menu that appears.

Value and Percent

• If Value is chosen, the numbers represent values in the 0-to-255 pixel scale
regardless of the bit depth of your output image.

• If Percent is chosen, the numbers represent the percentage of intensity.

Color Meter Options

The Color Meter options let you choose the size of your sample display area. For
instance, if you choose 5 x 5 as your sample area, this means your K value will
represent color information for a 5-pixel by 5-pixel area. If you choose 1 x 1 (the
default), the color information pertains to a single pixel — the pixel in the middle
of the sample area.
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 A. Checked
Scan Job

Elements of the Scan Job Queue window

C. Image type

E. Title of
scan job

D. Image size

G. One-pass
Scan for
Multiple Scan
Jobs

H. Multiple
Auto-crop

for EZ-Lock
Film Holder

I. Function buttons for controlling scan jobs
(i.e. Up/Down arrow, Duplicate, New, Delete, Check, and Load Save)

F. Selected
Scan Job
(highlighted)

B. Current
Scan Job

Scan Job Queue Window

The Scan Job Queue window provides several functions for managing your scan
jobs. By definition, a scan job contains the following elements:  a set of scanning
parameters (shown in the Settings window); a scan frame (shown in the Preview
window); and one or several scan job items (shown in the Scan Job Queue
window).

You can have multiple scan jobs, each having its own distinct settings; the
number of scan jobs is indicated by the number of titles in the Scan Job Queue
window (two in the example below). Scan jobs marked with a check are the ones
designated to be scanned, and the jobs are scanned in the order that they
appear in the Scan Job Queue window.

You can choose to show or hide the Scan Job Queue window in ScanWizard
Medi. To do this, click the Show/Hide Scan Job Queue window toggle command
under the View menu in the Preview window.

Clicking the
Window
Expansion
button to
expand the
Scan Job
Queue
window.
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A.. Checked scan job:  Checked scan jobs are the ones that are scanned when
you click the Smart-Scan button or Scan to button in the Preview window.  To
check a scan job, you can either click the Check icon or use the Check
button at the bottom of the Scan Job Queue window.

B Current scan job:  This is the current scan job, indicated by a frame around
the title. There may be several defined scan jobs, but only one scan job can
be current. In the Preview window, the current scan job is the one with the
flashing marquee.

C. Image type display:  This shows the image type of the scan job .

D. Image size:  This is the image size of the scan job.

E Title of scan job:  The title of each scan job is shown. To edit a scan job title,
double-click the title of scan job and type a new name when an edit box
appears.

F. Selected scan job:  The selected scan job is the highlighted item. You can
have multiple selected scan jobs, and clicking on a function button (such as
Check or Duplicate) will implement that function on the selected scan job.

G. One-pass Scan for Multiple Scan Jobs:  This allows the scanner performs
scanning in a single pass for all the selected scan jobs.

H. Multiple Auto-crop for EZ-Lock Film Holder:  This allows the scanner
automatically performs an Auto-crop after scanning multiple films at one
time.

D. Function buttons for controlling scan jobs:  These buttons perform a
specific action on the selected scan job. The Duplicate, New, Delete, Check
and Load/Save buttons can be used on multiple selected scan jobs.

E. Thumbnail of prescan image:  A thumbnail ( ) appears for the selected
scan job after you click the Prescan button in the Preview window. This
means a prescan image is available for that scan job. This function is
available only  in the Reflective mode.
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One-pass Scan for Multiple Scan Jobs

If this option is unchecked, when you assign multiple scan jobs in the preview
window, the scanner will continuously scan for several passes, depending on the
number of scan jobs that are selected. For instance, assuming that there are
three scan jobs selected, the scanner performs the first job, and as the scanner
carriage returns to the stand-by position, the scan for the second job begins, and
so forth to the third job — for a total of three passes. More scan jobs there are,
the longer the scanner time will be.

If this option is checked, the scanner performs scanning in a single pass for all
the selected scan jobs. The scanner’s carriage moves only once and when it
returns to the stand-by position, ScanWizard Medi then starts to process and
finish all of the scan jobs.

Note:  This function will be carried out automatically once you apply the Smart-Scan
button on your scan; therefore, there is no need to check this option from Scan Job
Queue window when you are scanning X-ray films (positive films).

To use the “One-pass Scan for Multiple Jobs”, the image original should meet the
following conditions:

1. For all the scan jobs, the “resolution x scale” value in the Settings window
should be the same.

2. All the scan jobs should have the same scan type.

3. If the screen filter is applied, all the scan jobs should use the same descreen
lpi value.

If ScanWizard Medi has detected that your image original does not meet the
above conditions, the “One-pass Scan for Multiple Jobs” option is dimmed and
will not be available for selection.
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Multiple Auto-crop for EZ-Lock Film Holder

This option is enabled only when the EZ-Lock film holder (or medical series film
holder)  is placed on the scanner glass surface, and the scan material is X-ray
film (positive film). Otherwise, this option is disabled. Check this option to
enable the scanner to auto-crop multiple scanning frames.

Note:  This function is always checked when you are scanning X-ray films (positive films).

To perform multiple auto-crop preview of the film loaded onto the scanner, click
the Smart-Scan button. When done, you will see multiple scan frames that have
been automatically cropped in the preview window. Multiple job titles will
appear in the Scan Job Queue window, numbered sequentially and all marked by
a “Check” that indicates the jobs are ready to be scanned.

Note:  After performing multiple auto-crop scanning, the previously created jobs will be
removed from the Scan Job Queue window.
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Function Buttons

Selecting Multiple Scan Jobs
The Duplicate, Delete, and Check buttons at the bottom of the Scan Job Queue
window can be used for multiple job selections.

For example, you can select multiple scan jobs, and then click the Delete button
to remove all the jobs simultaneously.

To select multiple scan jobs, press the Ctrl or Shift key and click on the jobs to be
selected.

Editing Multiple Scan Jobs
ScanWizard Medi lets you edit multiple scan jobs at the same time, increasing
your efficiency in using the software.

To edit multiple scan jobs, simply select all the scan jobs to be edited in the Scan
Job Queue window.

To include each scan job for selection, use the Shift + Click combination
(pressing the Shift key while clicking the mouse at the same time). Then perform
the selected editing function.

For instance, you can go to the Settings window and choose an image type that
will apply to all the scan jobs. Another example is to apply a common resolution
setting to all the scan jobs. Simultaneous editing simplifies the scanning process
for you.
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Adding a New Scan Job
The New button lets you create a new scan job; the new scan job will have
default settings. This feature allows you to create as many scan jobs as you wish,
and each scan job can then have its own settings.

1. Click the New button.

2. When a title of new scan job appears, accept the default name or enter a
name for the new scan job. Use unique names for your scan jobs, as
duplicate names are not accepted.

3. Define the scan frame in the Preview window for the new scan job.

4. In the Settings window, specify the settings for the new scan job. With the
creation of a new scan job, the new scan job becomes the current scan job.

Duplicating a Scan Job
The Duplicate button lets you duplicate the settings of a scan job. This function
is very helpful if you have created optimal settings for a scan job and wish to use
these settings as a template for other scan jobs. This saves time, as you don’t
have to create the settings repeatedly for every scan job you make.

1. From the list of scan jobs available, select the scan job(s) to be duplicated.

2. Click the Duplicate button. The selected scan job(s) will be duplicated. The
Duplicate function is very useful when scanning several images at the same
settings.

Removing a Scan Job
The Delete button allows you to remove a scan job from the list of scan jobs
available.

To delete a scan job, highlight the scan job to be removed, then click the Delete
button.
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Checking a Scan Job
The Check button allows you to select the scan jobs to be scanned. Checked
scan jobs are the ones that are scanned when you click the Smart-Scan button or
Scan to button in the Preview window. The check button is a toggle for checking/
unchecking a scan job.

To check a scan job, highlight the scan job, then click the Check button. A check
sign will appear next to the selected scan job.

To uncheck a scan job, highlight the scan job, then click the Check button. The
scan job will be unchecked, and the scan job will not be scanned when you click
on the Scan button.

The Up/Down Arrows
The Up/Down arrows allow you to change the order of the scan jobs in the Scan
Job Queue window.

To move up/down the scan job, highlight the scan job, then click the Up/Down
arrow to change the order of the scan job in the list.

When you start scanning, the scan jobs will be processed and scanned in the
order that they appear in the Scan Job Queue window.
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The Load/Save button
The Load/Save button allows you save scan jobs that can be loaded at a later
time when necessary. The idea of saving and loading scan jobs has important
applications, especially for scanners with different templates or “trays”. Loading/
Saving scan jobs is also useful if you consistently work in a specific format, scan
the same kind of images, or if the scanner is used by several users who have
their own sets of jobs.

To save a scan job as a template:

1. Click on the Load/Save button to open the Job Template Manager window.

2. Specify a folder for saving scan jobs by clicking the Folder icon (yellow) or
use the current default folder.

3. Highlight the scan jobs you want to save at the right column of the window.

4. Click the <<Save button in the window. The selected scan jobs will be saved
into the chosen folder and appeared at the left column of the window.

You may also specify different folders for respective scan job templates as
you desired.

To load a scan job template:

1. Click the Load/Save button to open the Job Template Manager window..

2. Switch to the folder where the scan job template is stored.

3. Highlight the scan job template to be loaded at the left column of the
window.

Before loading a new scan job, you may remove your existing scan jobs
from the right column

4. Click the Add>> button in the window to load the scan jobs from a chosen
folder into the Scan Job Queue window.
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To remove a scan job template:

1. Click the Load/Save button to open the Job Template Manager window..

2. Highlight the scan job to be removed at the right column of the window.

3. Click the Remove or Remove all button in the window to remove the scan job
from  the Scan Job Queue.

New name auto given if the name already exists

When you load or save scan jobs, you may check or uncheck the “New name
auto given if the name already exists” option in the window. Suppose the scan
jobs already exist, if you check this check box, the number suffix is automatically
appended as a new scan job. If unchecked, the existing scan jobs are
overwritten.
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Appendix

Product and Technical Support

If you need to call Technical Support, please have the following information
ready:

• Your scanner model. The scanner product name is indicated on the front (or
top) of the scanner, not the back.

• The scanner's serial number. This can be found on the back panel of the
scanner.

• Your computer name and model.

• The version number of ScanWizard Medi. This is indicated on the
ScanWizard Medi scanning software.

• Your system components, or the devices on your system, such as an external
hard drive, CD-ROM, etc.

• Software being used with your scanner.

Important

Aside from having the above information ready, please make sure that when
calling technical support, you (or someone calling for you) are knowledgeable
about the basic operations that may need to be performed on PCs. These
procedures include:

• How to edit the CONFIG.SYS file

• How to edit the Windows WIN.INI file

Microtek's technical support will not walk you through these procedures. You
are assumed to have knowledge of your Windows system.
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